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1 Mousing
First, how do we move around and select things?

Left-mouse Drag Rotate view
Ctrl Left-Mouse Drag Translates view
Shift Left-Mouse Label Atom
Right-Mouse Drag Zoom in and out
Middle-mouse Centre on atom
Scroll-wheel Forward Increase map contour level
Scroll-wheel Backward Decrease map contour level

2 Introductory Tutorial
In this tutorial, we will learn how to do the following:

1. Start Coot

2. Display coordinates

3. Display a map

4. Zoom in and out

5. Recentre on Different Atoms

6. Change the Clipping (Slab)

7. Recontour the Map

8. Change the Map Colour

9. Display rotamers and refine residue

2.1 Get the files
Before we start, let’s get the files on which we will be working:

$ wget http://www.biop.ox.ac.uk/coot/tutorial/tutorial-modern.pdb
$ wget http://www.biop.ox.ac.uk/coot/tutorial/rnasa-1.8-all refmac1.mtz

2.2 Start Coot
To use coot, in a terminal window, type:

$ coot
When you first start coot, it should look something like Figure 1.

2.3 Display Coordinates
So let’s read in those coordinates:

• Select “File” from the Coot menu-bar1

• Select the “Open Coordinates”menu item
[Coot displays a Coordinates File Selection window]

1Note you can also use “Alt-F” instead of clicking on “File”
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Figure 1: Coot at Startup
Not much to see at present... Actually, after this, coot screenshots will be
displayed with a white background, whereas you will see a black one

• Either

– Select tutorial-modern.pdb from the “Files” list

or

– Type tutorial-modern.pdb in the Selection: entry

• Click “OK” in the Coordinates File Selection window
[Coot displays the coordinates in the Graphics Window]

2.4 Adjust Virtual Trackball
By default, Coot has a “virtual trackball” to relate the motion of the molecule to
the motion of the mouse. Many people don’t like this.

So you might like to try the following. In the Coot main menu-bar:
Edit → Preferences. . .
[Coot displays a Preferences window]
On the left toolbar select General and then on the right top notebook tab HID.

Select “Flat” to change the mouse motion.
(Use the “Spherical Surface” option to turn it back to how it is by default).
What is the difference? “Flat” mode is like the mode used by “O”. In both

modes, dragging the mouse near the centre of the screen causes the view to rotate
about the X- or Y- axis. However in spherical mode you can also rotate about the
z-axis by dragging the mouse along an edge of the window.

2.5 Display maps
We are at the stage where we are looking at the results of the refinement. The
refinement programs stores its data (labelled lists of structure factor amplitudes
and phases) in an “MTZ” file. Let’s take a look. . .
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Figure 2: Coot After Loading Coordinates

• Select “File” from the Coot menu-bar

• Select “Auto Open MTZ” menu item [Coot displays a Dataset File Selection
window]

• Select the filename rnasa-1.8-all refmac1.mtz

If you choose instead “Open MTZ, cif or phs...” you will see:

• [Coot displays a Dataset File Selection window]

• Select the filename rnasa-1.8-all refmac1.mtz

[Coot displays a Dataset Column Label Selection window]
Notice that you have a selection of different column labels for the “Ampli-
tudes” and “Phases”, however, let’s use the defaults: “FWT” and “PHWT”.

• Press “OK” in the Column Label Window
Nowopen theMTZfile and select column labels “DELFWT” and “PHDELWT”.
So now we have 2 maps (whether auto-opened or not).

2.6 Zoom in and out
To zoom in, click Right-mouse and drag it left-to-right2. To zoom out again, move
the mouse the opposite way.

2.7 Recentre on Different Atoms
• Select “Draw” from the Coot menu-bar

• Select “Go To Atom. . . ”
[Coot displays the Go To Atom window]

2or up-to-down, if you prefer that
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Figure 3: Coot MTZ Column Label Selection Window

Figure 4: Coot after reading an MTZ file and zoomed in.
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• Expand the tree for the “A” chain

• Select 1 ASP in the residue list

• Click “Apply” in the Go To Atom window

• At your leisure, use “Next Residue” and “Previous Residue” (or “Space” and
“Shift” “Space”in the graphics window) to move along the chain.

• Click Middle-mouse over an atom in the graphics window
[Coot recentres on that atom]

• Ctrl Left-mouse & Drag moves the view around. If this is a too slow and
jerky:

– Select Edit → Preferences. . . from Coot’s menu-bar
– Select the “Maps” toolbutton on the left
– Select the “Dragged Map” notebook tab.
– Select “No” in the “Active Map on Dragging” window
– Click “OK” in the “Preferences” window

Now the map is recontoured at the end of the drag, not at each step3.
Another, additional way tomake the movements faster is to change the num-
ber of steps for the “Smooth Recentering”. Again you find this in the “Prefer-
ences” (Preferences → General → Smooth Recentering). Change the “Num-
ber of Steps” from the default 80 to something smaller, e.g. 20.

• You can display the contacts too, as you do this:

– Select “Measures” from the Coot menu-bar
– Select “Environment Distances. . . ”
– Click on the “Show Residue Environment?” check-button

∗ Also Click “Label Atom?” if you wish the Cα atoms of the residues
to be labelled.

– Click “OK” in the Environment Distances window
– Click “Apply” in the Go To Atom window
[You can’t change the colour of the Environment distances]

You can turn off the Environment distances if you like.

2.8 Change the Clipping (Slab)
• Select “Draw” from the Coot menu-bar

• Select “Clipping. . . ” from the sub-menu
[Coot displays a Clipping window]

• Adjust the slider to the clipping of your choice

• Click “OK” in the Clipping window

Alternatively, you can use “D” and “F”4 on the keyboard, or Control Right-
mouse up/down (Control Right-mouse left/right does z-translation).

3which looks less good on faster computers.
4think: Depth of Field.
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Figure 5: Coot’s Go To AtomWindow (it doesn’t look exactly like this any more).

Figure 6: Coot showing Atom Label and environment distances.
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2.9 Recontour the Map
• Scroll your scroll-wheel forwards one click5

[Coot recontours the map using a 0.05electron/Å3 higher contour level]

• Scroll your scroll-wheel forwards and backwards more notches and see the
contour level changing.

• If you don’t have a wheel on your mouse you can use “+” and “-” on the
keyboard.

• Note that the “Scroll” button in the Display Manager allows you to select
which map is affected by this6.

2.10 Change the Map Colour
• Select “Edit” from the Coot menu-bar

• Select “Map Colour” in the sub-menu

• Select “1 xxx FWT PHWT” in the sub-menu
[Coot displays a Map Colour Selection window]

• Choose a new colour by clicking on the colour widgets
[Coot changes the map colour to match the selection ]

• Click “OK” in the Map Colour Selection window

2.11 Select a Map
Select a map for model building:

Menubar: Calculate → Model/Fit/Refine...
[Coot displays the Model/Fit/Refine window]

Select “Select Map. . . ” from the Model/Fit/Refine window
click OK (you want to select the map with “. . . FWT PHWT”)

Alternatively you can use the modelling toolbar icon buttons (here “Map”) dis-
played on the right side of the Coot window. Most options found in theModel/Fit/Refine
window are available here too. If you are not sure which icon corresponds to
which function look at the displayed tips when over the button with the mouse.
Or change the display style of the buttons by clicking on the bottom arrow and
select another style to get only or additionally text displayed.

3 Model Building
“So what’s wrong with this structure?” you might ask.

There are several ways to analyse structural problems and some of them are
available in Coot.

Validate → Density Fit Analysis → tutorial-modern.pdb
[Coot displays a bar graph]

5don’t click it down.
6by default it is the last map, which is not necessarily the map that you want.
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Look at the graph. The bigger and redder the bar the worse the geometry. There
are 2 area of outstanding badness in the A chain, around 41A and 89A.
Let’s look at 89A first - click on the block for 89A.

[Coot moves the view so that 89A CA is at the centre of the screen ]

3.1 Rotamers
• Examine the situation. . . [ The sidechain is pointing the wrong way. Let’s Fix it...]

• Menubar: Calculate → Model/Fit/Refine... 7

[Coot displays the Model/Fit/Refine window]

• Select “Rotamers” from the Model/Fit/Refine window 8.

• In the graphics window, (left-mouse) click on an atom of residue 89A (the
Cγ, say)
[Coot displays the “Select Rotamer” window]

• Choose the Rotamer that most closely puts the atoms into the side-chain den-
sity

• Click “Accept” in the “Select Rotamer” window
[Coot updates the coordinates to the selected rotamer]

• Click “Real Space Refine Zone” in the Model/Fit/Refine window9.

• In the graphics window, click on an atom of residue 89A. Click it again.
[Coot displays the refined coordinates in white in the graphics and a new
“Accept Refinement” window]

• Click “Accept” in the “Accept Refinement” window.
[Coot updates the coordinates to the refined coordinates. 89A now fits the
density nicely.]

OK. That’s good.
Now, how about if we just use Real Space Refinement only?

• Click “Undo” twice
[Coot puts the sidechain back to the original position]

• Click “Real Space Refine Zone” in the Model/Fit/Refine window10.

• In the graphics window, click on an atom of residue 89A. Click it again.
[Coot displays the refined coordinates in white in the graphics and a new
“Accept Refinement” window]

• Now using left-mouse, click and drag on the intermediate (white) CZ atom
of the PHE (if you mis-click the atom, the view will rotate).

• Can you pull the atom around so that the side-chain fits the density?
[Yes, you can]

7or use the modelling toolbar on the right of the Coot window, i.e. you don’t need to open the
Model/Fit/Refine window

8Or click on the “Rotamers” button of the modelling toolbar
9. . . or use the modelling toolbar button
10. . . or modelling toolbar button
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Figure 7: 89A now fits the density nicely.

3.2 More Real Space Refinement
Now let’s have a look at the other region of outstanding badness:

• Click on the graph block for 41 A
[Coot moves the view so that 41A CA is at the centre of the screen]

• Examine the situation. . .

• Residue 41 is in a mess and not fitting to the density. Can you fix it?
[Yes, you can]

• The trick is Real Space Refine that zone. So. . .

• You can either Real Space Refine a few residues (40, 41 and 42) or just 41.
Take your pick.

• Click on “Real Space Refine Zone” in the Model/Fit/Refine window

• Select a range by clicking on atoms in the graphics window (either atoms in
40 then 42 or an atom in 41 twice)
[Coot displays intermediate (white) atoms]

• Click and drag on some atoms until the atoms fit nicely in the density.
If you want to move a single atom then Ctrl Left-mouse to pick and move (just)
that intermediate atom.
[Note: Selecting and moving just the Carbonyl Oxygen is a good idea - use Ctrl
Left-mouse to move just one atom.]
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4 Blobology - Optional
This is an optional section11 - generally you are expected to skip this and move on
to “Use the EDS”. However, if you have time and are feeling adventurous (this is
not expected) you can explore more density fitting tools:

4.1 Find Blobs
To be found under Validate (called “Unmodelled Blobs”).

Select the map and the coordinates (which are used to arrange the waters in the
unit cell “close to” the protein).

You can use the defaults in the subsequent pop-up. Press “Find Blobs” and
wait a short while.

You will get a new window that tell you that it has found unexplaned blobs.
Time to find out what they are.

4.1.1 Blob 3

Let’s start from Blob 3 (the blobs are ordered biggest to smallest - Blobs 3 and 4 (if
you have it) are the smallest).

• Click on “Blob 3”
[Coot centres the screen on a blob]

• Examine the situation. . .
[We need something tetrahedral there. . . ]

• “Place Atom At Pointer” on the Model/Fit/Refine window12

[Coot shows a Pointer Atom Type window]

• “SO4” in the new window. . .

• In the “Pointer Atom Added to Molecule:” frame, change “New Molecule”
to ‘‘tutorial-modern.pdb”

• Click OK.

• Examine the situation. . .

• the orientation is not quite right.

• Let’s Real Space Refine it (you should know what to do by now. . . )

• (“Real Space Refine Zone” then click an atom in the SO4 twice. Accept)
[The SO4 fits better now].

4.1.2 Blobs 2 and 1

These are the blobs due to missing loops and the enzyme substrate.

Can you find the right tools to fit these parts of the map?
[No. Well, not easily. I am going to move on to the next section. . . ]

11for the speedy.
12also available in the modelling toolbar
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5 Use the EDS
OK, so now you have some basics under your belt. We now want you to assess the
quality of models given an electron density map generated from the experimental
data. There are many thousands are structures with maps in the database, here are
a few examples:

• 2bf6

• 2aeq

• 3gvl

Download them using:

• Menubar: File → Fetch PDB and Map using EDS...

For each of these structures, consider how difficult it is to place the atoms given
the electron density map. For the structures 2aeq and 3gvl consider the ligands
in particular13. Are the models consistent with the data and prior knowledge of
carboydrate chemistry or might the depositors havemade amodel-building error?

6 Extra Fun
Coot is Free Software. Google for it and you can download it and play with it at
home.

[Yeah, like I’m going to do that!]

13use the “Go To Ligand” toolbutton in the toolbar for rapid navigation
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